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Finding Trapped Miners Using a Prototype Seismic 

Recording System made from Music Recording 

Hardware 

 

Thomas L. Pratt 
U.S. Geological Survey, School of Oceanography, University of Washington, Seattle, WA 98195; 206-543-7358; 
tpratt@ocean.washington.edu 

 

Executive Summary 

The goal of this project was to use off-the-shelf music recording equipment to build and test a prototype 
seismic system to listen for people trapped in underground chambers (mines, caves, collapsed buildings). Previous 
workers found that an array of geophones is effective in locating trapped miners; displaying the data graphically, as 
well as playing it back into an audio device (headphones) at high speeds, was found to be effective for locating 
underground tapping. The desired system should record the data digitally to allow for further analysis, be capable of 
displaying the data graphically, allow for rudimentary analysis (bandpass filter, deconvolution), and allow the user 
to listen to the data at varying speeds.  

Although existing seismic reflection systems are adequate to record, display and analyze the data, they are 
relatively expensive and difficult to use and do not have an audio playback option. This makes it difficult for 
individual mines to have a system waiting on the shelf for an emergency. In contrast, music recording systems, like 
the one I used to construct the prototype system, can be purchased for about 20 percent of the cost of a seismic 
reflection system and are designed to be much easier to use. The prototype system makes use of an ~$3,000, 16-
channel music recording system made by Presonus, Inc., of Baton Rouge, Louisiana. Other manufacturers make 
competitive systems that would serve equally well. Connecting the geophones to the recording system required the 
only custom part of this system - a connector that takes the output from the geophone cable and breaks it into 16 
microphone inputs to be connected to the music recording system. The connector took about 1 day of technician 
time to build, using about $300 in off-the-shelf parts. 

Comparisons of the music recording system and a standard seismic reflection system (A 24-channel 
“Geode” system manufactured by Geometrics, Inc., of San Jose, California) were carried out at two locations. Initial 
recordings of small hammer taps were carried out in a small field in Seattle, Washington; more elaborate tests were 
carried out at the San Juan Coal Mine in San Juan, New Mexico, in which miners underground were signaling. The 
comparisons demonstrate that the recordings made by the two systems are nearly identical, indicating that either 
system adequately records the data from the geophones. In either system the data can quickly be converted to a 
format (Society of Exploration Geophysicists ‘Y’ format; “SEGY”) to allow for filtering and other signal 
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processing. With a modest software development effort, it is clear that either system could produce equivalent data 
products (SEGY data and audio data) within a few minutes of finishing the recording. 

The two systems both have significant advantages and drawbacks. With the seismograph, the tapping was 
distinctly visible when it occurred during a time window that was displayed. I have not identified or developed 
software for converting the resulting data to sound recordings that can be heard, but this limitation could be 
overcome with a trivial software development effort. The main drawbacks to the seismograph are that it does not 
allow for real-time listening, it is expensive to purchase, and it contains many features that are not utilized for this 
application. The music recording system is simple to use (it is designed for a general user, rather than a trained 
technician), allows for listening during recording, and has the advantage of using inexpensive, off-the-shelf 
components. It also allows for quick (within minutes) playback of the audio data at varying speeds. The data display 
by the software in the prototype system, however, is clearly inferior to the display on the seismograph. The music 
system also has the drawback of substantially oversampling the data by a factor of 24 (48,000 samples per second 
versus 2,000 samples per second) because the user interface only allows limited subsampling. This latter drawback 
will either need to be modified in the proprietary software, or the system will not be effective until computer speeds 
increase so that the data flow is faster. 

The primary drawback to either of these systems in the field is the data flow issue. It is effectively a full-
time job to continuously record data with either system. This leaves little time for a single operator to analyze the 
data, and it requires the recording system and computer to be devoted solely to recording data, not analyzing it. One 
potential solution is to network the recording computer to a second computer using Microsoft Windows’ existing 
file-sharing capabilities and a crossover cable to connect the two computers. One person can then operate the 
recording system, while a second person analyzes the data after bringing the already-recorded data over to the 
second computer. Alternatively, one computer can be used to record continuous, 16-channel data, while a second 
computer records 2 channels at a lower sample rate (sums of channels 1-8 and 9-16). The latter computer would 
easily have enough power to continue recording in the background while data analysis is carried out.  

 

Introduction 

The goal of this project was to construct a low-cost, prototype seismic recording system for helping rescue 
personnel determine if people trapped underground are alive and, if so,  to locate them.. The assumption is that the 
trapped person(s) will be making noise by tapping on the sides of the chamber (mine, cave, tunnel collapsed 
building). The intent is for the rescuers at the surface, or in adjacent parts of the structure, to use seismic waves, 
which are sound waves transmitted through rock, to locate the victim(s). 

Rapidly locating and communicating with people trapped in underground mines or caverns, or in collapsed 
buildings, is crucial to their survival. Such disasters often destroy communications and air systems, and hypothermia 
can be an immediate concern in underground conditions. Cell phones rarely work from underground, and cell 
phones are not durable enough to survive underground conditions for long. It is, therefore, difficult after a mine or 
tunnel disaster to determine whether people are alive underground, and where they are located. 

The most obvious form of communication with people trapped underground is by tapping on the walls or 
ceiling of the underground chamber with a hammer or other object. There is a set protocol for communicating with 
trapped miners - searchers above ground set off five explosive shots to tell the miners that they are searching, and 
the miners know to hammer on the ceiling 5 times at 15-minute intervals on the quarter hour. Others trapped 
underground are likely to try the standard ‘SOS’ signal of three quick taps, three taps with longer pauses, and three 
more quick taps. 

One effective method of identifying trapped people tapping on the walls of an underground chamber is to 
play the seismic recording back at higher speeds. Because the regular beat of someone tapping is distinct from most 
natural noise, the pattern can be used to distinguish tapping from random noise bursts. The problem is that the 
tapping is low amplitude and at a frequency at the lower range of human hearing (10 to 100 Hz), and it therefore 
sounds “muffled”. Playing an amplified recording back at 4 or 8 times the original speed raises the frequency of the 
taps to 40 to 800 Hz, which is closer to the center frequency of human hearing, and shortens the time between taps 
to make them more obvious. 

It has been known for some time that seismographs like those used for subsurface imaging in the petroleum 
industry work well to locate underground tapping. In the early 1970s, a group of geophysicists from Conoco, Inc., 
did extensive testing and concluded that the most effective way of locating miners tapping on the ceiling of a mine 
was to use a closely-spaced array of geophones (Fowler, 1973). The array of geophones allows the weak signals to 
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be detected above coherent and random (for example, wind) noise because of the continuity of the signal on 
multiple, nearby receivers. In contrast, individual geophones, like those used to locate earthquakes, do not work well 
because the signal often is not strong enough to confidently identify it within the background noise. The use of a 
multichannel array simplifies the location process - the underground noise nearly always arrives first at the nearest 
geophone. 
 The primary drawback to using a seismograph for locating persons trapped underground is that the standard 
recording systems are complex, are designed for a different application, and are expensive (in 2008, the systems cost 
about $30,000 to $40,000 after installing extra memory and software for continuous recording). The expense makes 
it unlikely that many mines or search and rescue teams will be able to purchase a system, and bringing a system in 
from far away costs precious hours. The complexity makes the systems intimidating to use and requires training, 
which also delays response by requiring “experts” to travel to the scene from long distances. 
 The system I propose combines seismic sensors (geophones) with off-the-shelf music recording equipment 
to make an inexpensive, relatively easy-to-use seismic system for locating trapped people. The use of mass-
produced, music recording equipment dramatically lowers the price in comparison with the more specialized seismic 
systems. The music systems also have the advantage of being easily used to listen directly to the sensors with 
headphones, eliminating the delay involved in converting recorded seismic data into a format that can be played 
using sound equipment. Music recording equipment also comes with easy-to-use graphics user interface (GUI) 
software to record the data on standard laptop computers, thus simplifying the recording setup and operation. 
 This report outlines the basic principles for locating people trapped underground, and it describes the 
prototype low-cost seismic system I developed for this project. 
 
 

 

Detecting Trapped People by Using Seismic Reflection Systems 

Data. The initial data used in this report were collected in 2007 using a 48-channel seismograph. The specific 
system used was a “Geode” seismic recording system manufactured by Geometrics Inc., of San Jose, California. The 
Geode is an industry-standard seismic reflection recording system widely used for high-resolution, shallow seismic 
profiling. This seismic system was used to record a series of taps created by a miner at about 600 ft depth hitting the 
ceiling of a mine with a 6 ft-long, 4”x4” timber.  

 
  
Basic Principles. The basic physical principle used in this project is that sound waves emanate in a quasi-spherical 
manner from a sound source at depth (a person hammering on the walls of an underground chamber) at an average 
seismic velocity determined by the speed of sound in the rocks above the chamber. The term “quasi-spherical” is 
used because the sphere is modified when passing through materials with different seismic velocities, but a spherical 
shape is a good approximation (fig. 1). 
 The implication of spherical spreading of sound waves in a constant seismic velocity material is that the 
seismic energy reaches the (flat) surface first at the receiver located nearest the sound source and later at the more 
distant receivers. The shape of the curve follows the equation 
 
 

T2=T0
2 + X2/V2,   (1) 

 
where T is the traveltime to an arbitrary geophone, T0 is the traveltime to the geophone at the surface directly above 
the sound source, X is the distance between an arbitrary geophone and the point at the surface directly above the 
sound source, and V is the velocity (speed) of sound in the material above the chamber. 
 The sound waves emanating from striking the wall or ceiling of an underground chamber will be in a 
frequency range that is dependent on the material and distance. For common materials like a sledgehammer or 
timber striking solid rock, the frequency range will likely be in the 5 to 500 Hz range; softer materials will likely 
have a lower overall frequency. If the hammer is striking softer material, such as coal, the frequency content may be 
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at the lower end of the frequency range, and the strength of the signal may be weaker because some of the energy 
will be absorbed by deforming the soft coal. Harder materials will likely produce higher frequency signals. 
 
 
 

  
 
Figure 1. A, Diagram of a spherical sound wave emanating from an underground noise source, such as a person 
striking the top, walls or floor of an underground chamber. The sound waves spread in all directions with a speed 
equal to the speed of sound within the material. B, If the sound wave is recorded by a linear string of detectors at the 
surface, it will first arrive at the detector directly above the source, and later at the more distant detectors. The shape 
of the sound wave on graphs of the ground motion (seismic traces) will by a hyperbolic curve with a shape given by 
equation (1).  
 
 
Detection of tapping using high-speed playback. The first goal of a rescue operation for someone trapped 
underground is to determine if they are alive. In the absence of cell phones or other electronic means, the most 
logical way to detect the person is through sound, specifically seismic signals traveling through the ground. Ideally it 
would be best to detect any noise, but the most likely signal to be detected is the person hammering (tapping) on the 
sides of the underground chamber with a hard object. This object will not necessarily be metal, because a miner 
might be reluctant to cause a spark by striking a rock with a metal object in the presence of methane gas. For this 
reason, the tests we show here were conducted using a 4”x4”, six-ft-long timber striking the ceiling of a mine at a 
depth of about 600 ft. 

The Conoco researchers noted, and we verified, that the taps were far more obvious if the seismic 
recordings were converted to an acoustic record and played back at faster speeds. Figure 2 shows graphically a 
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portion of the sound recordings collected during these tests. Graphical displays of the raw recording do not show an 
obvious tapping signal above the ambient background noise. Limiting the signals to between 30 and 120 Hz 
(bandpass filter) removes much of the background noise, but still only two taps are obvious on the graphical display. 
Using a deconvolution, or predictive error filter, that removes cyclic noise, such as that emanating from motors 
(Yilmaz, 1987; Robinson and Treitel, 1980), does not noticeably enhance the recording we are working with, 
although it might prove extremely useful in noisier environments, for example if a pump is running nearby to 
prevent flooding. Any unnecessary equipment should be shut down during a rescue operation, but pumps and 
ventilation equipment are likely to be required to keep water out and to keep air flowing into a collapsed mine. 

Converting the signals shown in figure 2 into sound recordings demonstrates how well taps can be heard 
when a seismic signal is played back at faster speeds. Recordings in WAV format can be played by ‘cntl-clicking’ 
on the hyperlinks imbedded in this text. File “taps.wav” [use ‘cntl-click’ to play] is the original recording after a 30-
120 Hz bandpass filter has been applied to enhance the tapping. The tapping of the miner is barely audible as a 
muffled set of low-frequency taps; it is more obvious if the bass level on the speakers is increased. (The voices are 
of the people at the surface making the recordings, which were picked up by the geophones.) Although you can hear 
the taps on the 16-second sound clip, it would be very difficult to recognize them if listening to several hours of 
recordings. 

File “tapsX4.wav” is the same recording played at 4 times the speed. When played faster, the taps are 
obvious and would easily be recognized even if listening to a long recording. 
 There are two reasons that high-speed playback of the seismic signal makes detection of the taps easier. 
First, increasing the speed reduces the time between the individual taps to a shorter time interval, which makes the 
rhythmic “beat” more noticeable. Second, speeding up the recording raises the frequency of the signal closer to the 
center of the human hearing range. The original taps have frequencies primarily in the 30 to 120 Hz range, which is 
near the lower limit of human hearing (the range of human hearing is generally regarded as about 20 Hz to 20,000 
Hz). Playing the seismic recordings back at 4 times the original speed changes the frequency content of the signal to 
120 to 480 Hz, which is solidly within the range of human hearing (nearly equivalent to low C [128 Hz] to high C 
[512 Hz] on a piano). The taps, therefore, change from a muffled “thud” to a sharper, more distinct “tap.” 

http://pubs.usgs.gov/of/2009/1095/taps.wav
http://pubs.usgs.gov/of/2009/1095/tapsX4.wav
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Figure 2. Five mine taps recorded on two geophones located 940 ft apart, with the first geophone placed directly 
above the source of the tapping (left trace). Arrows on the left and right denote the times of the taps. The unfiltered 
(raw) recordings are on the left. Filtering the recordings with a 30 to 120 Hz filter makes some, but not all, of the 
taps visible. Deconvolving using standard seismic reflection methods (Yilmaz, 1987; Robinson and Treitel, 1980) 
sharpens the signal, but does not make it more visible on the single receivers. However, deconvolution, which 
removes cyclic noise, may be extremely important for recordings made near machinery, such as pumps. 
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The importance of multi-channel arrays. The other way to make the taps more detectable is to 
use a multi-channel seismic array. Figure 2, which shows the recordings made on individual 
receivers, demonstrates that the taps are barely visible on seismic recordings made using a single 
receiver. After filtering, two of the taps can be seen on the receiver directly above the miner, but 
the other three taps remain lost in the ambient noise, and no taps can be identified on the more 
distant receiver. Thus, it is clear that a signal recorded on only a few receivers will only be 
detected graphically under ideal circumstances. 

A simple way to increase the prominence of the signal is to use an array of nearby 
geophones. Figure 3 shows the same set of taps as figure 2, but this time recorded on 16 nearby 
receivers (a line of receivers with 20 ft between each receiver). The reason the taps are obvious 
on the multi-channel record is that they are recorded at nearly the same time on all of the 
receivers, whereas much of the noise is local to individual receivers. 

A large number of geophones (receivers) are not needed to record a signal well. Figure 4 
shows a comparison of the same taps recorded on a 48-element array (20 ft spacing) and on a 16-
element array (every third element of the previous array). The taps are obvious on both arrays. 
The use of 16 receivers versus 48 receivers is important because it suggests that large systems 
are not needed. Specifically, off-the-shelf music recording systems can be purchased cheaply to 
record 16 channels, but few inexpensive systems can record 48 channels. 

In addition to recognizing the taps, the shape of the tap on the seismic array can be used 
to locate the miners. The source of the taps is located approximately beneath the earliest arrivals 
(fig. 5) because the sound has the shortest distance to travel to that geophone. By moving the 
array toward the shallow part of the arrival, rescuers can soon place the array directly above the 
miners and thus locate them accurately. 

The shape of the recorded taps on the multi-channel array suggests a simple strategy for 
locating a person trapped underground: place the array near where the person is expected to be, 
and see which geophone first receives the signal. The person is in the direction of the first signal. 
A series of simple tests in which the array is moved from place to place should be able to locate 
the trapped person. 
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Figure 3. A, First 16 records  from a 48-channel seismograph showing surface recordings of a miner tapping on the 
roof of a mine at 550 foot depth using a 4”x4” timber. The miner is beneath the leftmost geophone. The 5 taps are 
not clearly identifiable above background noise. B, The same mine taps after filtering the records with a 30 to 120 
Hz bandpass filter. The 5 taps are readily identifiable because of their coherency across the seismic array. C, Same 
records after bandpass filtering and deconvolution. Although deconvolution did not make a significant change in 
these records, it can be very effective at eliminating cyclic noise, such as noise from pumps or motors. 
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Figure 4. comparison of recordings made with a 48-channel array and with a 16-channel array. The 48-channel array 
consisted of 48 geophones spaced 20 ft apart, with the miner located beneath the leftmost geophone. The 16-channel 
array is created by taking every third geophone from the previous array. The results demonstrate that even a modest 
number of receivers will produce an interpretable signal. As shown in figure 5, close-ups of the individual taps make 
them obvious on the display. 
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Figure 5. Close-up display of one of the mine taps shown in the previous figures, with the horizontal axis being 
distance in ft. The shape of the tap is approximately hyperbolic, as predicted from seismic theory. The top of the 
hyperbola is located nearly directly above the miner. In this case, the first arrival is on the fourth geophone, which is 
actually located about 60 feet from the point above the miner. This discrepancy is likely due to variations in the 
speed of sound in the rocks above the mine. 
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Low-Cost Seismic System Based on Music Recording Systems 

Description of Basics 

 

The prototype system used an off-the-shelf, 16-channel music recording system. The specific system used 
for the prototype is an 8-channel Digimax “Firestudio” system with an 8-channel “Digimax FS” slave recording 
unit. Both units were manufactured by Presonus, Inc., of Baton Rouge, Louisiana (www.presonus.com), and they 
were selected based on internet searches and the recommendation of a recording engineer. Other companies make 
similar systems, but the Presonus unit was recommended as having high-quality preamplifiers. This is a rapidly 
evolving technology, however, so any competitive advantage may change at any time. The key technical 
specifications of the system are given in table 1. Photos of the front and back of the prototype system are shown in 
figures 6 and 7. A photograph of the custom-built connector to go from the geophone cable to the music recording 
system is shown in figure 8. 

 

 
Figure 6. Front view of the prototype system with descriptions of the key components and features. Note that the 
sample-rate lights (lower right on the lower, Digimax unit) are set at 48,000 samples/second, that the “clock sync” 
light shines a steady blue (top right on the upper, Firestudio unit), and that the “external sync” light on the lower, 
Digimax unit (right hand side) shines a steady red (meaning ADAT synchronization). The “Phantom Power” 
switches on the far left of both units, which can be used to deliver power to microphones, are turned off (no light). 
The power conditioner is optional, and was not used when running off DC power. 

http://www.presonus.com
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Figure 7. Back view of the prototype system. Note that these two Digimax systems are being used only as analog 
preamplifiers, so the sample rates and clock synchronization are irrelevant on these back units (thus, the “Internal 
Clock” lights on the right are lit). The “Phantom Power” switches on the far left of both units, which can be used to 
deliver power to microphones, are turned off (no light). 
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Figure 8. Custom-built connector made to connect the 24-channel geophone cable to the 16-channel music recording 
system. Channels 1-16 in the geophone cable are connected to XLR microphone connectors. Channels 17-24 on the 
geophone cable are not used. A newer version of this connector has 24 microphone connectors, thus allowing any 16 
of the 24 channels to be recorded. 
 
 

The cost of the hardware was $899 for the Firestudio unit and $599 for each of the three Digimax units. 
The Firestudio plus 3 Digimax units thus cost a total of $2700. The additional cables, headphones, connectors and 
case (portable rack mount) added about $600 to the total cost. Assembling the system took about 1 day of 
technician’s time. This compares with a cost of approximately $20,000 for a basic, 24-channel Geode seismic 
recording system. The Geode used in the field tests was a nearly $40,000 unit after the addition of extra components 
to allow for continuous recording. 

The Firestudio and the Digimax slave unit each contain eight 24-bit Analog-to-Digital (A/D) converters. 
Inputs consist of either 0.25 inch microphone jacks or XLR microphone inputs. The prototype system uses the XLR 
inputs because they have a consistent response across all channels; the 0.25 inch microphone inputs have different 
impedances in the first 2 channels, which are intended for guitar, rather than microphone, inputs. The 0.25 inch 
microphone inputs could be used, but would likely require different gain settings on the first two channels of each 
unit. 

The Firestudio and Digimax slave unit are connected with fiber-optic cables that allow their clocks to be 
synchronized with the computer, and for digital data to be transferred from the Digimax to the Firestudio. The 
Firestudio sends the 16 channels of digitized recordings to the (laptop) computer through a firewire port. On the 
computer, the Firestudio software synchronizes the clocks on all three systems (laptop, Firestudio, Digimax) and can 
be used to set the recording parameters (channels, sample rate) in the Firestudio. 
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Every channel on the recording system has a separate preamp volume, which is set with a dial. These 
preamplifiers are identical in both the Firestudio and the Digimax slave unit. The technical specifications state that 
there is a -6 dB to +55 dB range to the preamplifiers. This amplification range was found to be suitable for high-
amplitude recordings, such as the early tap tests in the urban Seattle area. However, when trying to record lower-
amplitude signals it was clear that further amplification was needed. 

To increase the amplification of the overall signal, a second set of Digimax units was used as preamplifiers 
to further amplify the signal going into the digital recording system. The signals entering the Digimax slave unit can 
either be recorded digitally through the Firewire connection to the laptop computer (maximum of 8 channels plus the 
8 on the Firestudio), or the amplified analog signal can be taken off 0.25 inch headphone jacks in the back of the 
unit. These jacks are intended for headphone monitoring, but in the prototype system I took the 16 analog output 
channels from two Digimax preamp units and fed them into the 16 input channels (8 Digimax and 8 Firestudio) that 
were recorded by the computer. Thus, I amplified the signals twice by feeding them through two sets of 
preamplifiers. In practice, more units could be cascaded to further amplify the signal. For example, it would be 
trivial to rewire the prototype system so that eight channels could be amplified 4 times (once through each of the 3 
Digimax units and once in the Firestudio). I found that amplifying the signal by using two preamplifiers provided 
enough dynamic range to record signals at the same strength as the Geode system. I generally set all of the 
preamplifiers to about 75 percent of their full amplification. 

The most difficult part of the recording system is the Firestudio software for controlling the Firestudio and 
Digimax units. This software has input and output functions that allow any input channel to be mapped into any 
output channel, or summed into any combination of channels. Although this is an appealing feature, it is not an 
intuitive system to understand or work with. However, it is easy to set up default parameters in which each channel 
is directly recorded on the laptop, and all channels are summed into the headphone outputs. This interface is the only 
part of the software that required testing and training. 

The input channels are, by default, directly recorded as channels 1-16 on the computer. On the front of the 
Firestudio is a headphone output, however, and it is straightforward to sum channels 1-8 (or any combination) into 
one earphone and channels 9-16 (or any combination) into the second earphone. This gives the potential of having a 
stereo listening system to try and detect the direction from which the tapping is coming. 

One important point to note is that the Firestudio and Digmax systems can be programmed by the 
computer, and they can then run as a separate system without the computer. In practice, this means that the system 
can be used for listening with headphones, without requiring the laptop computer for recording. This suggests an 
alternative operating mode in which a number of Firestudio units, running on batteries, each could be used in 
conjunction with 8-channel geophone cables to listen independently for tapping above different parts of a mine. 
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Table 1: Technical specifications of the Presonus Firestudio recording system, as described on page 33 of the user’s 
manual. 
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Recording Software 

 

Recording on the computer can be done with the proprietary software included with the Firestudio system, 
but I found the free software package “Audacity” (SourceForge; http://audacity.sourceforge.net/) to be simpler to 
use; this is certainly in part because I had experience with Audacity before undertaking this project, but I 
nonetheless find the Audacity recording software to be extremely intuitive to use. My 15-year old son quickly 
learned to use Audacity for recording music. I therefore used it in the prototype system and did not install the 
propriety software that came with the Firestudio. 

The only real parameters that need to be set to begin recording with “Audacity” are the sample rate and the 
number of channels – nearly everything else can be allowed to default. The sample rate must be set in two places: 
(1) in the Firestudio software (this is easy to locate), and (2) in the Audacity recording system. In the latter, the 
relevant input parameters are located in the menu 

 
Edit > Preferences > Audio I/O, 

 
in which you set the recording hardware (Presonus); and in 
 

Edit > Preferences > Quality, 
 
in which you set the sample rate and the internal sample representation (16-bit integer or 32-bit floating point). I 
generally use a sample rate of 48,000 samples per second because it is readily subsampled into 1,000, 2,000 or 4,000 
samples per second. For internal representation I use 32-bit floating point because it is the most accurate. The 
number of channels to record is controlled in the menu 
 
  Edit>Preferences>Audio IO. 
 

The format in which you want to record the data in Audacity is set in the menu 
 

Edit > Preferences > File Format. 
 
I recorded the data in headerless RAW format with a 32-bit floating-point number (little endian on a PC computer). 
This format was easily converted to the geophysical industry standard Society of Exploration Geophysicists 
“SEGY” format, which can then be used as input to a number of software packages for data processing. 

Once these initial parameters are set, the recording can be completely controlled by the Audacity interface 
(the Firestudio is always sending data to the laptop). Specifically, the “record” button will begin recording, and the 
“stop” button will terminate recording. The menu to save the data to disk is 

 
File > Export Multiple. 
 

This menu will bring up a dialog box that can be used to export the data to disk in your chosen format. You can also 
do some simple analyses or reformatting of the data in Audacity using the following options. 
 

Effect > Change Speed    (this will resample the data as well as allow playback at a faster or slower speed). 
 
Effect>FFT  Filter  (this will allow you to design a bandpass filter, with more detailed filtering possible if 

you expand the pop-up window width with your mouse to get more accurate control on the frequencies). 
 
There are other effects in the “Effect” menu, designed for music, that may be applicable to recording the 

taps, such as the “Normalize,” “Click Removal” and “Amplify” options.  
Finally, Audacity is a music editor and, therefore, it allows the user to delete portions of the recordings, 

listen to individual channels (using “mute” or “solo”), and copy portions of the data. 

http://audacity.sourceforge.net/
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Although the above sounds complicated, it is simple to use most of the default settings. When I first purchased the 
Presonus system, I hooked it up to the laptop computer and turned it on. Within a few minutes I was recording 16 
channels of microphone inputs. 

The most nagging issue with the hardware, however, is the clock synchronization. The sample rate MUST 
be correctly set to the same values in both Audacity and in the Firestudio, and the “External Sync” button on the 
Digimax unit MUST be set to “ADAT” (red light). The system will take as much as a minute before the blue 
“synchronization” light on the top right corner of the Firestudio unit stops flashing and shines a steady blue, 
although after using the system a few times it almost immediately synchronizes. The sample rate lights on the 
Digimax unit (bottom right) should be lit to the proper sample rate. Unfortunately, it is fairly common for the units 
to lose synchronization, and it sometimes required rebooting of the laptop to re-establish synchronization. 
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Figure 9. Screenshot showing the Audacity recording interface with 16 channels being recorded. Each channel has a 
separate, elongated display window. The horizontal scale on top is time in minutes:seconds (note the 1 minute mark 
in top right). Each channel can be played individually or summed into the right or left stereo channel. 
 

Reformatting Music Recordings to SEGY Format for Analysis (Alternatively Using Music 

Software for Analysis) 

 

Once the data are recorded, there are two options for analysis. The first is to keep the recordings in a music 
format, such as WAV or MP3, and to analyze the data using software designed for editing and processing music. 
The capabilities of such software, of which Audacity is one example, are limited, especially in the filtering and 
displaying of data. One obvious step that can be taken when the data are in music format is to speed the recording up 
to listen for the taps at higher playback speeds as described earlier (Effects>Change Speed  in Audacity). 
 For filtering and graphic analysis, however, the data can be analyzed much more effectively if read into a 
geophysical software package. In this project I have used the Colorado School of Mines’ “Seismic Unix” (SU) 
software package. This is a free software installation available for download from the Colorado School of Mines’ 
Center for Wave Phenomena (CWP) at http://www.cwp.mines.edu. For this project, the software was installed under 
the “cygwin” Linux emulator, which is free from the “Free Software Foundation” at www.cygwin.com. 
 To convert the data into the SEGY geophysics industry format, the data were written by Audacity as 
headerless “RAW” files consisting of a string of floating point numbers. To do this, the output format in Audacity is 

http://www.cwp.mines.edu
http://www.cygwin.com
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set using the “Edit>Formats>RAW, 32 bit floating point” option. Using the File>ExportMultiple command will 
write the data as 16 individual files in RAW format. 
 The data were converted to SEGY (actually the nearly identical “SU” [Seismic Unix] format) using the 
script shown in table 2, below. The script reads the data as seismic traces, filters them, resamples them, and rewrites 
them as headerless files. The script can then read them in as the final seismic (SEGY) traces with a length of 30 sec. 
The reason an extra write step is needed is that SEGY format limits the maximum number of samples allowed in a 
trace to 32767 samples (216). Thus, the data need to be read in as short traces, resampled, written back to disk, and 
then read in at the final sample rate and trace length. 
 Once resampled and converted to SEGY format, the data can be processed as any geophysical data. 
Potential processes that I have applied to the data in this report include filter, deconvolution and display. 
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Table 2. Unix Script for converting data from headerless RAW format to SEGY (SU) format. 
 
# The script reads multiple tracks of raw files (32-bit floating point; big-endian; no header),  
# resamples to 1000 samples/sec (1 msec dt) , and writes out segy traces of 1/2 minute length 
#  Script assumes wav data are recorded at 48000 samples per second and have 1 track per file 
# (as written by the Audacity music recording system) 
#  48000 smaples/sec does not divide evenly into 1000 samples per sec, so we will assume it is actually 50,000 samples 
per sec 
#  (this speeds the sound track up by about 4%.  This only affects the filter values, as the data are later read in 
correctly) 
 
 
#modify the next two lines to set the file name and the number of channels 
name="test2"   #will be appended in front of "-1.raw".  e.g. test-1.raw 
  # program will read successive wav files from 1 to "chans" 
chans=16 
 
#need to get rid of the 0 in front of the file numbers 
mv $name"-01.raw" $name"-1.raw" 
mv $name"-02.raw" $name"-2.raw" 
mv $name"-03.raw" $name"-3.raw" 
mv $name"-04.raw" $name"-4.raw" 
mv $name"-05.raw" $name"-5.raw" 
mv $name"-06.raw" $name"-6.raw" 
mv $name"-07.raw" $name"-7.raw" 
mv $name"-08.raw" $name"-8.raw" 
mv $name"-09.raw" $name"-9.raw" 
 
#should not need to change anything below this line 
#************************************************************ 
 
#zero out files 
>$name.su 
>temp 
>temp2 
 
#now read each file and append to the SU file 
filenum=1   #recording channel number 
while [ $filenum -le $chans ] 
do 
 
 #break raw file into 1/2 sec traces, anti-alias filter, resample to 480 samps/sec and write data to temp file 
 suaddhead ftn=0 tsort=3 ns=24000 <$name-$filenum.raw |  #24000 samples is less than 32767 segy limit 
 sushw key=dt a=20 |                     #20 microsec dt actually assumes 50000 samps/sec but gives integer dt 
 sufilter f=1,2,240,480 |          #anit-alias filter, sound equipment does not record below about 5 Hz 
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 suresamp rf=0.02 |    #convert from 48000 to 960 samples per sec 
 sustrip >temp     #strip headers off so that we can combine traces in next step 
 
 #add 1/2 minute of zeros to make sure we complete any partially-recorded half-minutes 
 sunull dt=1000 nt=30000 ntr=1 | sustrip >>temp  #nt and dt are meaningless, as we strip header off 
 
 #now read in 1-min (60-sec) traces 
 suaddhead ftn=0 tsort=3 ns=28800 <temp |  #read 1/2 minute of data at 960 samps/sec 
 sushw key=dt,minute,sec,tracf a=1042,0,0,$filenum b=0,1,30,0 >>temp2 #set dt, channel (tracf), min, secs 
# suresamp dt=1000 nt=30000 >>temp2    #resample to 1000 s/sec and write 1/2-minute traces 
# suximage perc=98 <temp2 
 
 #add some null traces between minutes 
 #sunull dt=2083 nt=28800 ntr=2 | sushw key=minute,tracf a=1000,$filenum >>temp2  
 
 filenum=`bc -l <<END      #now go to next channel number (next file) 
  $filenum + 1 
 
END` 
done 
 
#now sort the data into 1/2-minute groupings (gathers) 
susort minute tracf <temp2 >$name.su 
 
#suxwigb perc=100 xcur=2 <$name.su & 
 
#rm temp* 
 
 
#***************************************************** 
#Now do some simple processing to display the data 
 
suwind tmin=0 <$name.su | 
#suascii bare=2 | more 
sugain pbal=1 | 
suxwigb perc=100 xcur=2 title="raw data, no bandpass" &  
 
 



 22 

Comparisons with Seismic Reflection System (Geode) 

Tap Tests 

Initial tests of the seismic system were conducted in a small field in Seattle. An array of twelve 8-Hz geophones was 
placed in the ground with about a 6-ft spacing between geophones. Tap tests were then conducted by striking a 
concrete sidewalk about 1 foot from the first geophone with a standard claw hammer. The hits were very gentle, 
equivalent to dropping the hammer head about 6 inches, because harder hits overdrove the geophones, causing 
clipping. 

The hammer taps were recorded with two seismic systems: a standard, 24-channel Geode recording system, 
and the prototype system put together with sound recording equipment. Because I only had one set of geophones and 
a single geophone cable, the tests were conducted by recording a set of taps with one instrument, and then plugging 
the geophone cable into the second instrument to record a similar set of taps. 

Figures 10 and 11 show comparisons of raw and filtered recordings made with the Geode and music 
recording systems. The two systems recorded different sets of hammer taps, but the recordings are nonetheless 
nearly identical. Clearly, both systems adequately record the input signals from the geophones. 
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Figure 10. Comparison of hammer taps recorded on a Geode system and recorded on the Presonus system. Traces 1, 
3, 5,… were recorded on the Presonus system; traces 2, 4, 6,… are equivalent traces recorded using the same 
geophones (but a different hammer tap). Note that the waveforms are very similar despite being from different 
hammer taps. 
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Figure 11. Comparison of hammer taps recorded with the Geode and music recording systems. As in the previous 
figure, traces 1, 3, 5,… were recorded on the Presonus system and traces 2, 4, 6,… are equivalent traces recorded 
using the same geophones (but a different hammer tap). Data in this figure were filtered with a 10-20-120-160 Hz 
bandpass filter and deconvolution with a 0.008 sec gap length. Again note that the waveforms are very similar 
despite being from different hammer taps. 
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Tests at San Juan Mine, New Mexico 

 

The tests at the San Juan mine also show that the Presonus system and the Geode system record nearly 
identical records. For these tests, we laid out two parallel but identical receiver arrays with corresponding geophones 
located within 1 foot of each other. The end of the receiver array was located almost directly above a rescue 
chamber at about 500-ft depth. Geophones had a 14 Hz resonant frequency. 

Miners repeated a sequence of signals consisting of 5 hits of the roof of the mine using a 4”x4” timber, 
waited 30 seconds, then used a sledgehammer to strike the ground 5 times. This sequence was first given directly 
below the end of the receiver array. The miners then repeated the sequence 200, 400, 600 and 800 ft from the 
original location. 

Figure 12 shows the same 8-second section of recordings made with the two systems. The data have had 
minimal processing (10-20-60-120 Hz trapezoidal bandpass filter only). Both systems clearly recorded the taps from 
within the mine, with the major arrivals and the major noise characteristics being similar on the two recordings. 
Figure 13 shows a close-up of the third tap in the previous figure. The waveforms are not identical, but are very 
similar. The music system appears to be richer in higher frequencies, as the wavelets appear to be slightly sharper 
than those recorded on the Geode system. The higher frequencies may be due in part to the attenuation of 
frequencies below about 20 Hz on the music system. Figure 14 shows that the frequency spectra are nearly identical 
between the two systems, although the music system was powered by AC current so it has 60-Hz noise on it. In 
subsequent tests we powered the music system using DC current, which eliminated the 60-Hz noise. 

Figure 15 shows the on-screen display from the Presonus/Audacity system with taps displayed on the 16 
channels. 
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Figure 12. Set of 4 taps from a timber hitting the roof of a chamber located about 500 feet beneath the leftmost trace, 
recorded on the 16-channel music recording system and on the first 16 channels of the 24-channel seismic reflection 
system. The sources are identical, but the two data sets were recorded on two different sets of geophones planted 
about 1 foot apart. The data differ in detail, but the overall recordings are very similar. Times are meaningless, as 
they refer to the time within a record after manually starting the recording systems. 
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Figure 13. Enlargement of the third tap in figure 12, showing the individual waveforms. The recordings have had a 
10-20-60-120 Hz trapezoidal bandpass filter, but no other processing. The waveforms show the same features, but 
differ slightly in detail, with the Geode system appearing to be slightly richer in low frequencies. 
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Figure 14. Frequency spectra for the data in figure 12. 
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Figure 15. Display of taps on the Audacity system from beneath the geophone array, with 5 taps between 1:14.15 
and 1:14.9 (minute:sec listed at top of display). The miner was at a depth of about 500 feet beneath one end of the 
array (channel 1, top). The records have been sped up by a factor of 12, so the 0.2 to 0.3 sec between taps is actually 
2.4 to 3.6 sec. The record has been bandpass filtered from 0 to about 100 Hz. 
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Which System is Better for Finding Trapped Miners? 

It is clear from our tests that both the seismic (Geode) and music (Presonus) systems are adequate for 
accurately recording the signal from geophones. The utility of the systems depends instead on the trade-offs of ease 
of use, cost, and data flow. 

The main advantages of the music system are its much lower cost, its relative ease of use, and the ability to 
listen directly to the geophones in real time using headphones. I found in my tests that the tapping could often be 
heard directly through the headphones as a distinct, muffled “thud.” The Geode system, however, was clearly 
superior in displaying the records, and nearly every “tap” could be identified immediately on the seismic system 
when the system was in display mode rather than write mode. Unfortunately, the Geode system is in display mode 
only about 50 percent of the time. 

Once the data are recorded, the systems are about equal in their data analysis capabilities. In both cases, the 
data can be quickly filtered and displayed on a laptop computer using the Seismic Unix or other software. 
 Another potential advantage to the music system, however, is that it is actually a pair of 8-channel systems. 
These two systems could potentially be separated and used independently to listen to geophones if searchers are 
attempting to cover a wide area more rapidly (obviously they would need to be housed in separate cases). 
 An obvious advantage to the Geode system is that it is a 24-channel rather than 16-channel system. In 
principle the music system can also be configured to record 24 channels, but the display is limited to 16 channels. 
 

Tradeoffs between the Systems 

 

A number of factors need to be considered when thinking about implementing a system for finding people trapped 
underground. 
 
Ruggedness. Given that the two systems record nearly identical signals, the question is which system has more price 
or logistical advantages. As mentioned above, the Presonus system is almost an order of magnitude cheaper per 
channel (~$300/channel versus ~$1,500 to $2,000/channel [after adding the extra components for continuous 
recording]) than the Geode system. One tradeoff is that the Geode system is weatherproofed and made rugged to 
better handle field conditions. The Geode system is also made to be small and light. Music recording systems are 
made for studio situations, and they are unlikely to withstand severe field conditions for prolonged periods of time. 
The prototype music system is housed in a tough, weatherproof case, which will presumably lengthen its lifetime 
over that of a more exposed system. The music system is cheap enough to replace several times and still be less 
expensive than the Geode system. However, in an emergency the system must not fail, so it would be worth testing 
how durable the music system really is under field conditions. Heavy rains and winds will reduce the effectiveness 
of any seismic recording system by substantially increasing the ambient noise. 
 
Cost and availability. The cost of the music system and the wide availability of comparable systems serve to 
potentially offset the ruggedness of the Geode system. Multiple music systems can be purchased and assembled for 
the price of a single Geode system, which would allow for a more rapid replacement schedule. Furthermore, music 
recording systems are readily available in most any major city, and many smaller cities, so replacements are more 
easily obtained should a system fail while in use. As long as the connector between the geophone cable and the 
microphone inputs is intact, it would probably be straightforward to use any music recording system for listening for 
trapped miners.  
 
Ease of use. Another advantage to the music system is the ease of use. These systems are designed with a graphical 
user interface that is easily installed on most any computer and is far more intuitive to use than the Geode system. 
The ease of use is in part due to the lack of geophysical jargon, such as “record length” and “trigger holdoff” that 
permeate the menu items in the Geode’s user interface. The music system has far fewer options, and the existing 
options are intuitive to the average person, therefore making it much easier to navigate for the untrained user. The 
Geodes are designed to be used by trained technicians, whereas the music systems are designed for untrained users.  
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Displays. The computer display on the Geode system is clearly superior when trying to detect weak signals. This is 
largely because the Geode allows for individual geophone recordings (traces) to cross adjacent traces. In contrast, 
the music system displays each geophone recording (channel) in a separate window (fig. 15), which limits the 
amplitude of the signal to the width of the window. Visual detection of the taps is, therefore, far superior on the 
Geode system. 
 The Geode also allows for display of data with a bandpass filter, regardless of whether the data are 
recorded with a bandpass filter. This allows the operator to record the full spectrum of data while looking at a band-
limited display of the same data. In contrast, the music system does not have an easy way to bandpass the data while 
it is being collected. After collection, the Audacity system has a straightforward bandpass filter. 
 However, the Geode system only displays about 50 percent of the data because it is writing to disk the 
other 50 percent of the time. The display freezes while data are being written to disk, which means that if a tap 
occurs while the system is writing, the operator will not be able to see it. This is a potentially severe handicap in life-
or-death situations where a missed tap could cause the search to fail. Although the Geode system also has an “event” 
trigger that could be used to continuously search for high-amplitude events, none of the mine taps we recorded were 
far enough above background noise levels that this feature would have been effective. 
 
Use of headphones. One huge advantage to the music system is that the operator can listen to the data and see it 
displayed at the same time. It was generally easy to identify the signals, certainly the stronger ones, simply by 
listening to the geophones. The music system is designed under the assumption that the headphones will be the 
primary user monitor, as recording engineers want to hear that the signal they are recording is of high quality. In 
contrast, the Geode system has no capability for real-time listening. The Geode data will have to be recorded and 
later converted to a sound format for listening. Despite the above, we found in our field tests that the Geode 
system’s superior graphics capabilities easily identified any taps that were recognized using the music system’s 
headphones. The converse was not true - some taps were obvious on the Geode graphics display but could not be 
clearly identified in real time through the music system’s headphones. 

 

Frequency response. One issue that I discussed with the engineers at Presonus is the frequency response of the 
prototype system. Music recordings are primarily in the 20 to 20,000 Hz frequency band, which is considered the 
range of human hearing. Within that frequency band, the Presonus system (and its competitors) has a remarkably flat 
frequency response for such a low-cost system. When recording mine taps we are not interested in higher 
frequencies, but the low-frequency response of the system may limit its ability. 

I did not specifically test the frequency response of the Presonus system in any systematic way. However, 
their engineers told me that the system has a relatively flat response down to about 10 Hz, at which point the 
response drops dramatically. The system, therefore, is not likely to be applicable for recording infrasonic signals 
much below 10 Hz, and certainly not below 5 Hz. 

Bandpass filter tests on the mine taps we recorded at the San Juan mine show that the taps were primarily 
in the 30 to 120 Hz range. This is well within the flat response of the Presonus system. We do not have tests at other 
mines to use in determining the uniformity of that frequency band; however, my experience with seismic reflection 
imaging surveys carried out with a sledgehammer source is that hammer blows are almost always in the 10 to 200 
Hz frequency range. I, therefore, do not anticipate that the Presonus system will have problems recording hammer 
hits (or timber hits) in mines. 

 
Problems with DC to AC inverters. An important lesson we learned in our tests is to not use AC power from an 
inverter when in the field away from the power grid. In our tests of the system we initially used a small inverter to 
power the Presonus system and our laptop, with the inverter running off a car battery. These small inverters emit 
strong electromagnetic signals that appear as high-amplitude, high-frequency (>5 kHz) noise spikes in the data (fig. 
16). These noise spikes are frequent enough and strong enough that they easily overwhelm the signal we are 
attempting to record. Thus, running the Presonus system and/or laptop computer from an inverter is not an option. 
The noise spikes caused by the inverter are not apparent on the Geode system because the anti-alias filter cuts out 
the high frequencies of the noise spikes. 

To bypass the inverter, we cut the power cords between the AC-DC transformer and the Presonus unit and 
hooked the power cords directly from car batteries to the Presonus units. The Presonus units require 18 to 30 volt 
DC power, so we hooked two car batteries in series to power the units with 24 volts. This arrangement bypassed the 
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need for the inverter, allowing for a much quieter recording environment. Running directly from a DC power source 
also obviated the need for the power conditioner shown in the photos of the prototype system (figs. 5 and 6). The 
Geode system also runs on battery power. 
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Figure 16. Screenshot showing the high-frequency noise spikes introduced by the DC to AC inverter. These spikes 
persist as long as the inverter is turned on, even if it is not connected to the electrical system recording the data. 
Thus, the spikes appear to be coming from induced currents, and no inverter can be turned on anywhere near the 
system. The spikes are easily removed by bandpass filtering, but they make it difficult to hear the tapping while 
listening to the geophones in real time. The display shows about 0.03 seconds of data (minute:sec scale at top of 
display). 
 
Power Consumption. We did not test the power consumption on the Presonus units, so we do not know how long 
they will run on a pair of car batteries. According to specifications, each of the Presonus units uses approximately 16 
watts of power; 64 watts are needed to run the entire system of 4 units. The laptop requires an additional ~100 watts 
of power. We used the systems for several hours in the field, but we recharged the car batteries between our tests. 
The Goede uses 0.65 watts/channel during acquisition, or 15.6 watts for a 24-channel system. A laptop computer is 
also required for the Geode system. Thus, the Geode system uses about 25 percent of the power that is needed to run 
the music system, although both use less power than the laptop computer. 

 

Floating point versus manually adjusted gain levels. One potential advantage that the Geode recording system has 
over the Presonus system is the use of floating-point gains. In the Geode system, the amplification (gain) level is 
continuously adjusted to maximize the dynamic range of the data as recorded. The gains are then adjusted to a 
normalized value when the data are written to disk. This is needed in recording seismic data because the size of the 
source (a dynamite shot, for example) is not always known in advance. 
 In contrast, the music recording system is designed to record at a continuous amplitude. This is possible in 
a music system because the gains can be optimized during “sound checks” before a performance or studio recording. 
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The musicians are asked to play the loudest portion of the music being performed, and the gain levels are set to 
prevent this level from clipping. 
 In the field, it was trivial to set the amplitudes of the amplifiers on the Presonus system so that background 
levels were recorded at about half of the maximum amplitude. This leaves about half of the total dynamic range of 
the system to record signal levels with amplitudes larger than background noise. An alternative method is to have 
someone jump on the ground about 100 ft from the geophones. The signal from the person jumping is likely to be 
larger than any mine taps, so setting the amplification levels to this maximum will presumably give an adequate 
recording. 
 Given that the sound system has a 24-bit A/D capability (and assuming recording using 32-bit numbers), 
the dynamic range of the recordings should be adequate to record any signal picked up by the geophones without the 
user needing to be overly sensitive to the gain settings.  
 
Sample rates. One huge drawback to the music system is that it is designed with a limited selection of sample rates, 
all of which are designed to not degrade the quality of recorded music. Because the range of human hearing is 
generally accepted to be 20 to 20,000 Hz, the music system has a minimum sample rate of more than 40,000 Hz to 
avoid aliasing. This means that the recordings of mine taps, which occur at much lower frequencies (0 to 300 Hz), 
are over-sampled by a factor of about 48. The music system, therefore, is manipulating and recording about 48 times 
the volume of data than is actually needed. 
 This data volume clearly hampers the recording and processing by substantially increasing the time for 
every step, and by dramatically increasing the disk space and memory needed by the system. 
 There are two potential solutions to the sample rate issue. One solution is to talk with the manufacturer 
about adding the option of lower sample rates. They may be willing to provide a customized version of their 
software for this purpose. It is unlikely they will modify the general version of their software, however, because they 
do not want to risk having customers incorrectly record music with a poor quality because of under-sampling. 
 The other potential solution is to wait for computer technology to evolve so that the data volume becomes 
less of an issue. Computers continue to nearly double in speed from year to year, so several years from now the 
computer speeds will make the oversampling less of an issue. 
 Another potential solution is to record only two channels of data for quick analysis. All 16 channels could 
be recorded on the main acquisition computer, but sets of 8 channels could be summed and recorded through the 
headphone output as two channels on a second computer. In other words, sum the first 8 and last 8 channels and feed 
them into the stereo headphone outputs (as is already being done). In addition to listening through headphones, 
however, the headphone signal could be split and recorded at a much lower sample rate on a second computer. This 
stereo recording could then be quickly played back at different speeds on the second computer while still recording 
the full data on the main recording system. 
 
 

Recording versus Analyzing Data - A Potential Solution 

A major impediment to using either the Geode or the music seismic system in the field is the conflict 
between recording data and analyzing data. In an emergency, continuous data will need to be recorded to ensure that 
rescuers do not miss any signals from the trapped people. At the same time, someone will need to be analyzing the 
data as it is recorded. This analysis will consist of playing the recordings back at higher speeds, filtering and 
displaying the data, and determining whether specific events are indeed taps from a trapped person. With either 
system, however, the computer resources and operator’s time are fully devoted to recording continuous data, leaving 
no time or resources to analyze the data that have already been recorded. 

Ideally, the recording will continue in the background while analysis is carried out on the data that have 
already been recorded. It is possible to visually analyze the data in the Audacity recording system - the File>New 
menu will open a second copy of Audacity that can be used to start a new recording window while analysis is 
carried out in the previous window. Playback is more difficult, as both versions of Audacity must use the same input 
and output sound devices. To play back one set of data, the output volume on the other would need to be muted. 
This would leave the operator with the option of only listening to one set of data. However, the operator could listen 
to the data being recorded by connecting earphones directly to the Presonus unit and using a second set of earphones 
to listen to the playback of the previously-recorded data on the computer’s sound output. 
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A possible solution to the recording versus analyzing conflict is to have a second laptop computer that is 
devoted to analysis and a second operator carrying out this analysis. To access the data from this second computer, a 
crossover cable could be connected between the two computers to allow the second computer to access the data on 
the recording computer’s disk. I have tested this arrangement with two laptops, although not under realistic 
conditions. The laptops I used lacked the computer and/or disk speed to carry out this operation effectively. 
Computer and disk speeds rapidly increase from year to year, however, so this likely will be a viable option within 
the next year or two. 

Another potential option is to reduce the data volume by summing adjacent channels. For an initial 
screening process, the Presonus system could be used to sum channels 1-8 and 9-16 into stereo channels in the 
headphone outputs. These two channels could then be recorded with a second laptop, which would then have 
adequate speed to experiment with playback at different speeds while still recording incoming stereo data. In the 
meantime, the main recording laptop could record the full 16 channels. 

Another compromise might be to sum adjacent channels to record only 8 channels coming from 16 
geophones. Halving the data volume would significantly reduce the load on the recording computer, potentially 
allowing analysis to be carried out while recording continues in the background. 

Again, the increasing computer speeds may allow the computer system to outgrow this problem by 
becoming fast enough in the near future to both record and analyze the data. 
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